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Downloading Firmware Updates 
 

- Revised - 
 

AIO’s, Master Controllers, Keypanels 
 
 
 
 
The following has been derived from the AZedit Help File, version 2.08.01. 
 
 
 
NOTE:  Generally both master controllers and AIO cards are upgraded together.  However, when doing so, the 
AIO’s must be upgraded first, then the masters, 2nd. 
 
 
 
 

Updating Audio I/O Card Firmware 
 
Caution: The following procedure will cause one or more brief disruptions in intercom communications. 
 
1. Connect to the intercom system, and make sure that SERVER mode is deactivated as before. 
 
2. If you have not already done so, open the Audio I/O Card Status screen.  
 
Note: You can also perform this procedure from the Audio I/O Card Version Information screen, but the procedure 
is written using the Audio I/O Card Status screen, since that screen provides slightly more feedback during the 
update process. As an option, you can access both screens and then switch back and forth between them using the 
Go Back and Go Forward buttons.   
 
3. Select one or more of the Audio I/O cards. These are numbered 001, 002 etc.  Generally, we recommend 
selecting not more than ½ of a full frame at a time.  In less populated frames, it doesn’t matter. 
 
Important: Be aware that there is a 20-30 second period during the download process where the master controller 
will take each Audio I/O card off line and reprogram its firmware. Any disruption at this point (loss of power, card 
removal, manually resetting cards) will result in I/O card failure! 
 
If this happens, you will either have to return the affected cards for replacement, or you will have to remove the 
EEPROM chips from the affected cards and manually reprogram them with an EEPROM programming tool. Since 
this could potentially result in a major disruption, we recommend that you only update a limited number of I/O 
cards at a time, and updating should be performed during non-critical periods of intercom usage. 
 
4. Make sure AZedit is the active window, and not the help file. (Click anywhere on the AZedit window to make 
it the active window.) Then, press Ctrl+Shift+D or right click on the selected I/O cards. This will open the 
Firmware Download dialog. 
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Downloading Firmware Updates, cont’d. 
 
 
 

 
 

Firmware Download Dialog 
 
 
Note: If Ctrl+Shift+D or right click does not work, firmware download may be disabled. To enable this feature, go 
to the Options menu and select Preferences. Then, click on the Advanced tab. In the Advanced settings, place a 
check next to Allow firmware download, then click Apply. Click OK to exit. You should now be able to use the 
firmware download feature. Repeat step 4, above. 
 
5. Select the disk drive and folder where the firmware file is located, then select the file that you want to 
download. 
 
Note: For an ADAM CS Intercom System, the file name is AIO_cs.hex; for ADAM, the file name is AIO_std.hex. 
 
6. Click “open”.  The Download Device Firmware dialog will appear, and the download information will display 
in the upper-left corner. 
 
7. Click Begin Download. First the file will load. Then it will download to the master, and the percentage will be 
reported. 
 
Note: If there is any disruption in the communications link during the download, you will get an error message. In 
this case, repeat the download. 
 
When the file has been 100% downloaded, the master controller will begin updating the I/O cards. During this time, 
the Status column may display OK Old next to individual I/O cards, or it may display nothing. Also, intercom ports 
will go offline.  
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If performing this procedure from the I/O Status screen, the versions will dissappear for several seconds then 
slowly come back displaying the new versions. 
 
Important: Any disruption at this point (loss of power, card removal, manually resetting cards) will result in I/O 
card failure as previously described ! 
 
When the update is completed, the intercom ports will come back on line, and one-by-one, the status for 
I/O cards will change to OK Cur. The complete update procedure may take 3-5 minutes. You can verify 
the new firmware version in the Audio I/O Card Version Information screen. 
 
** Caution: The following procedure will cause one or more brief disruptions in intercom communications. Also, 
save your intercom system configuration before proceeding. (Use Save on the File menu. Then later, you will 
need to restore the intercom configuration from disk, use Send File in the Online menu.)  Also, masters & AIO’s 
are “hot swappable” so do not power down during controller updates. 
 

Master Controller Firmware Update, Part 1: All Intercom Systems 
 
1. Connect to the intercom system, and make sure that SERVER mode is deactivated. 
 

(Server Mode Activation or Deactivation) 
You must be ONLINE in order for this feature to be selectable. In the Online menu, click on Server Mode. A check 
mark will appear next to this item when it is active, and the word SERVER will appear in the lower-right corner of 
the screen. To deactivate this feature, click on Server Mode again, ONLINE will appear in the lower-right corner of 
the screen. 
 
Note: If you are using UPL statements to periodically update your intercom system, you may assure that your 
intercom system always connects to the intercom system in SERVER mode.  Set this feature as follows: 
 

A. Close all open dialogs. 
B. From the Options menu, select Preferences. 
C. Select the Startup / Shutdown tab. 
D. Place a check next to Auto enter SERVER mode 
E. Click Apply, then OK. 
F. You will have to restart AZedit in order for this setting to activate. 

 
2. If you have not already done so, open the Master Controller Status screen.  
 
Note: You can also perform this procedure from the Master Controller Version Information screen, but the 
procedure is written using the Master Controller Status screen, since that screen provides slightly more feedback 
during the update process. As an option, you can access both screens and then switch back and forth between them 
using the Go Back and Go Forward buttons.   
 
ADAM CS, or Single-Frame ADAM: There is only one master controller shown at a time. Click to select it. 
 
3. Make sure AZedit is the active window, and not the help file. (Click anywhere on the AZedit window to make 
it the active window.) Then, press Ctrl+Shift+D or simply right click on it and select “download firmware”.  This 
will open the Firmware Download dialog. 
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Note: If Ctrl+Shift+D or the right click does not work, firmware download may be disabled. To enable this feature, 
go to the Options menu and select Preferences. Then, click on the Advanced tab. In the Advanced settings, place a 
check next to Allow firmware download, then click Apply. Click OK to exit. You should now be able to use the 
firmware download feature. Repeat step 4, above. 
 
4. Select the disk drive and folder where the firmware file is located, then select the file that you want to 
download. 
 
Note: For an ADAM or ADAM CS intercom system, the firmware file name is “combined.hex”. 
 
5. Click “open”.  The Download Device Firmware dialog will appear, and the download information will display 
in the upper-left corner. 
 

 
 
5. Click Begin Download. A warning message my also appear asking you to remove the standby controller.  If 
so, do it and proceed.  First the file will load.  Then it will download to the master, and the percentage will be 
reported. 
 
Note: If there is any disruption in the communications link during the download, you will get an error message. In 
this case, repeat the download. 
 
When the file has been 100% downloaded, the master controller will begin processing the update. This may take a 
few minutes for the controller to stabilize.  Important: Any disruption at this point, such as a loss of power, 
removing or resetting cards (ADAM, ADAM CS) etc. will result in master controller failure! 
 
If this happens, you will either have to return the affected master for replacement, or you will have to remove the 
EEPROM chips from the affected master and manually reprogram them with an EEPROM programmer. Also, 
ADAM and ADAM CS users, do not proceed with the update of any more cards until you identify the problem. 
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ADAM CS or Single-Frame ADAM Systems: Allow 1 or 2 minutes for the update to complete.  You may also see a 
message that the intercom connection has been lost.  If this happens, wait about 15 to 30 seconds, then click Retry 
to restore the connection. You may have to do this once or twice. At some point, you will see the Slot indication 
change in the Master Controller Status screen. For example, if the Slot originally was the Right, it will change to 
the Left. This indicates that the standby master controller has taken over as the active master controller and is now 
ready to be updated.  Now proceed to Update, Part 2, ADAM CS and Single-Frame ADAM Systems. 
 

Master Controller Firmware Update, Part 2, ADAM CS and Single-Frame ADAM Systems 
 
1. Remove the master controller you have just updated and insert the other to be up dated and allow it to stabilize 
and go on line. 
 
2. Repeat the steps for this master controller as outlined in the previous section. 
 
3. Once this master controller stabilizes, insert the master so that both cards are in the frame. 
 
4. Check each master controller’s version to verify the download. 
 
5. Also check the status of both controllers that they each display “o.k. current” in the status screen. 
 
You may also see a Capabilities Conflict message after the update. This happens because the new firmware has 
now added new capabilities to both master controllers. Click Yes to update the capabilities.  
 
After you have cleared all messages, you will see the Slot indication change in the Master Controller Status screen. 
For example, if the Slot originally was Left, it will change to Right. This indicates that the standby master 
controller has taken over.  Note that this is the master controller that you first updated, so both master controllers 
are now updated. 
 
This completes the procedure to update an ADAM CS or single-frame ADAM intercom system. Note that the new 
firmware version should display in the Master Controller Version Information screen. 
 
Note: Depending on the differences between the old and new firmware, your intercom system may perform a "first 
birthday reset". For an ADAM CS Intercom System, this means that the intercom configuration settings in your 
master controller will be reset to the default size (64x64)for an ADAM CS Intercom System. 
 
Also on a "first birthday reset", all operating settings will be cleared and must be re-loaded from the previous file 
saved in the above in the first paragraph above. 
 
In a single-frame ADAM Intercom System (ADAM-136) this means that the intercom configuration settings in 
your master controllers will be reset to the default size (136x136) for an ADAM-136 Intercom System. If you 
previously customized your intercom configuration settings, you will have to redefine these in the master controller. 
To check the master controller intercom configuration, make sure that you are ONLINE, then access intercom 
configuration setup. Then, if the resource configuration is not correct for your intercom system size, perform the 
procedure Changing the master controller configuration settings. 
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Keypanel Firmware Updates 
 
General Information 
When you update keypanels, the update information is downloaded to the master controller from the configuration 
computer. Then, the update information is simultaneously sent to all of the Audio I/O cards where keypanels are 
being updated. From there, the update information is downloaded to individual keypanels. 
 
CAUTION: When selecting multiple keypanels for down load ONLY select keypanels of the same type or model.  
Do not try and to mix as firmware is different for each family. 
 
You can update one or several keypanels at the same time. However, when updating multiple keypanels connected 
to the same Audio I/O card, the update time could potentially be much longer. This is because the Audio I/O card 
must address each keypanel separately and then download the update information to that keypanel.  As a general 
rule, in this case, expect the total update time to be the update time for one keypanel times the number of keypanels 
on the same Audio I/O card that are being updated. 
 
For example, if the update time for one keypanel is 10 minutes, the update time for six keypanels of the same type 
on the same Audio I/O card could be as much as 60 minutes. When updating keypanels on separate Audio I/O 
cards, there is no additional time involved, since each Audio I/O card processes updates independently.  
 
Other factors affecting the overall download time include the amount of activity in the intercom system (potentially 
a major factor) and the baud rate for communications between the intercom system and the configuration computer 
(a relatively minor factor). 
 
Updates will proceed more quickly during periods of little activity, and when the baud rate has been set to the 
highest possible speed. 
 

Updating KP-12, DKP-8, DKP-12, and KP-8T Keypanels (KP-12 Type Keypanels) 
 
Caution: Do not remove power or disconnect the keypanel during this procedure. If you do, the flash EPROM in 
the keypanel will have to be replaced. Usually, downloads proceed without any type of problem. However, to be on 
the safe side, you may wish to limit downloads to small quantities of keypanels at a time.  
 
Note: As a general rule, it takes at least 10 minutes to update a KP-12 Type keypanel. To update multiple KP-12 
type keypanels on the same Audio I/O card will therefore take about 10 minutes times the number of keypanels 
being updated. 
 
1. Open the Keypanel Version Information screen and select the keypanel (or keypanels) that you want to update.  
The KP-12, DKP-8, DKP-12, and KP-8T keypanels will all show up as KP-12 version, and any combination of 
these keypanels may be selected for update.  Also, it does not matter if they currently have different versions of 
firmware.  However, do not also select keypanels of a different type, like ZEUS or KP-32, along with the KP-12 
type. 
 
2. To select several “same-type” keypanels at random, click on the first keypanel, then hold down the Ctrl key 
on the computer keyboard while clicking on additional keypanels. To select a range of keypanels, click on the first 
keypanel, then hold down the Shift key and click on the last keypanel in the range. 
 
3. With the keypanels now selected, press Shift+Ctrl+D or right click on the selection(s). This will open the 
Firmware Download dialog. 
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4. Select the folder where the firmware file is located, then select the file that you want to download. 
 
5. Click OK. The Download Device Firmware dialog will appear, and the download information will display in 
the upper-left corner. 
 
6. Click Begin Download. First the file will load. Then it will download to the master controller in the intercom 
system, and the percentage will be reported. When the file has been 100% downloaded, the master controller will 
begin sending the information to the keypanel. The keypanel will display DOWNLOAD in the Incoming Messages 
window, and all keypanel activity will be locked out while the flash is being re-written. It will take 4-5 minutes at 
this point for the keypanel to update. 
 
If you are viewing the Port Status screen, the Status column will display OK until just before the update is 
completed. Then Bad will display for a few moments and OK will return. The update is now completed. If you are 
viewing the Keypanel Version Information screen, the new keypanel version will appear when the update is 
completed. 
 
Repeat the above steps 1-6 to update more of same-type keypanels. 
 

BKP-4, MKP-4, TKP-4, WKP-4 Keypanel Update (Zeus Type Keypanels) 
 
Note: Zeus type keypanels can all recover from a failed download procedure.  No, chip replacement is needed. Just 
follow the instructions as listed below for this event. 
 
As a general rule, it takes at least 4 minutes to update a Zeus keypanel. To update multiple Zeus keypanels on the 
same Audio I/O card will therefore take about 4 minutes times the number of keypanels being updated. 
 
1. Open the Keypanel Version Information screen. 
 
2. Repeat steps referenced in Updating KP-12, DKP-8, DKP-12, and KP-8T Keypanels (KP-12 Type Keypanels) 
 
3. Click Begin Download. First the file will load. Then it will download to the master controller in the intercom 
system, and the percentage will be reported as the download progresses. When the file has been 100% downloaded, 
the master controller will begin sending the information to the Audio I/O cards. Since each selected keypanel on a 
card must be addressed separately, you will observe the following sequence of events occurring at different times 
for each keypanel. First RQDL will display in the Call waiting window. 
 
Now the Headset LED will flash green as the first chunk of data is being read from the Audio I/O card. After about 
1 to 2 minutes, OK 1 will display. This indicates that the first of 2 chunks of data has been updated. Again the 
Headset will flash green while the second chunk of data is being read. After another 1 to 2 minutes, OK 2 will 
briefly display and the keypanel will return to normal operation. 
 
The download is complete. Once normal operation is restored, the new keypanel version will appear in the 
Keypanel Version Information screen of AZedit. 
 
Note: If an error occurs at any time during the download, a lower-case "e" will appear in the left segment of the 
Call waiting display. The keypanel will automatically request that the failed chunk of data be resent. Allow 1 to 2 
minutes for the keypanel to repeat the previous step in the download process. If another error occurs, the first "e" 
will shift to the left and another "e" will appear. Again, the keypanel will request that the failed chunk be resent.  
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This process will go on indefinitely until either the download is successfully completed, or until someone 
downloads different firmware to the intercom system. Repeated download failures could indicate a problem with 
the intercom cable, or with the data transceiver on an Audio I/O card, or a data port problem on a particular 
keypanel. 
 

KP-32 Keypanel Update 
 
Note: The KP-32 can recover from a failed download procedure. No, chip replacement is needed. Just follow the 
instructions as listed below for this event. 
 
As a general rule, it takes at least 10 minutes to update a KP-32 Type keypanel. To update multiple KP-32 type 
keypanels on the same Audio I/O card will therefore take about 10 minutes times the number of keypanels being 
updated. 
 
1. Repeat steps referenced in Updating KP-12, DKP-8, DKP-12, and KP-8T Keypanels (KP-12 Type Keypanels) 
in selecting multiple same-type keypanels. 
 
2. Click Begin Download. First the file will load. Then it will download to the master controller in the intercom 
system, and the percentage will be reported as the download progresses. When the file has been 100% downloaded, 
the master controller will begin sending the information to the Audio I/O cards. Each keypanel will display "Code 
Download in progress" in the left side of the panel, and the chunk number will display. 
 
There are 10 chunks of data for the complete download. When the download is complete, the KP-32 will briefly 
display asterisks, then it will return to normal operation. Once normal operation is restored, the new keypanel 
version will appear in the Keypanel Version Information screen of AZedit. 
 
Note: If an error occurs at any time during the download, the keypanel will automatically request that the failed 
chunk of data be resent. "Try 2" will appear in the keypanel display. If another error occurs, "Try 3" will appear, 
and so forth. This process will go on indefinitely until either the download is successfully completed, or until 
someone downloads different firmware to the intercom system.  Repeated download failures could indicate a 
problem with the intercom cable, or with the data transceiver on an Audio I/O card, or a data port problem on a 
particular keypanel. 
 

KP-96-x Keypanel Firmware Update 
 
Requires physical EPROM change. 
 
 

End Downloading Firmware Updates 
 
 


